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Please Note 

Many of the values in these tables are set by the parameter data table file (PDT) these values can 
vary between games, and even between scenarios. The values used here are representative of 
typical values. The actual values for specific scenarios can be reviewed in game from the menu: 
“Help \ Parameter Data” or pressing F3. 

  



 

Terrain Codes 

 
The terrain code shows next to 
the terrain description. Several 
codes, may apply to a single 
hex. In the case above the hex 
is: 

o K= Cratered 
o X = Destroyed,  
o C = Covered 

K Cratered. 

X Destroyed 

I Indirect fire is not possible from this hex 

W 
Hex may not be entered or exited by wheeled vehicles unless via a 
road hex side (infantry can enter the hex without restriction) 

T 
Hex may not be entered or exited by tracked vehicles unless via a 
road hex side (infantry can enter the hex without restriction) 

V 
Hex may not be entered by either Wheeled or Tracked Vehicles 
unless via a road hex side. (Infantry can enter the hex without 
restriction) 

O Terrain is obstructed and prevents landing by helicopters. 

 
C 
 

Covered terrain, generates a special Immobility test when vehicles 
assault into it. 

NT No Tunnel movement allowed 

 

Whole Hex Terrain: 
Movement and 
Protection 

Terrain 
Height 

 Movement Costs 

Protection Infantry Wheeled Tracked 

Clear 
*Infantry 
derive their 
protection in 
clear terrain 
from the 
infantry 
protection 
parameter 
value usually 
set as 4 
 

 

0 0* 6 6 6 

Deep 
Water* 

 

0 X X X X 

Field 

 

0 0 8 12 8 

Brush 

 

0 0 8 12 8 

Vineyard 

 

0 0 12 24 24 

Orchard 

 

3 4 8 12 12 

Trees 

 

5 8 8 12 12 



Whole Hex Terrain: 
Movement and 
Protection 

Terrain 
Height 

 Movement Costs 

Protection Infantry Wheeled Tracked 

Marsh* 

 

0 0 18 X X 

Swamp 

 

4 4 18 X X 

Jungle 

 

6 10 18 X X 

Hard 

 

0 0 6 6 6 

Broken 

 

1 8 8 X X 

Sand 

 

0 0 8 24 12 

Rough 

 

1 8 12 X X 

Village 

 

3 6 8 8 8 

Town 

 

4 12 8 24 24 

City 

 

5 24 8 X X 

Industrial 

 

6 48 8 X X 

Rice 
Paddy 

 

0 8 8 12 12 

Shallow 
Water* 

 

0 0 8 12 12 

High 
Grass 

 

2 0 8 12 8 

*In snow or frozen conditions marsh or swamp terrain has the same movement cost as clear terrain and marsh, streams 
and all water hexes are not distinguishable from clear terrain. 
  



 

 

Effect of Ground Conditions on Movement 
 

 

Normal Soft Mud 
Snow & 
Frozen* 

Infantry 100% 125% 200% 150% 

Wheeled 100% 200% 400% 300% 

Tracked 100% 150% 300% 200% 

 
 

Linear Features: Movement and Protection 
 

 

  Movement Cost 
 Protection Infantry Wheeled Tracked 

Trail 
Trails provide no 
benefit to movement 
in snow or frozen 
terrain, in these 
conditions the 
movement cost will 
be that of the 
underlying terrain. 
And Trails will not be 
visible  

 

0 5 5 5 

Secondary 
Road 

 

0 4 4 4 

Primary Road 

 

0 3 3 3 

Railway 

 

8* 8 12 8 

Stream 

 

8 4 4 4 

Gully 

 

12 6 8 8 

Craters** 

 

2 3 3 3 

 
*For railways protection is afforded only for fire coming from the hex sides crossed by the rail. 
**Craters impose an additional movement cost to the underlying terrain 
***In frozen & snow conditions Trails & Streams, are not visible. In these conditions the movement cost is the same as 
that of the underlying terrain. 
  



Defensive 
Structures, 
Tunnels & 
Sewers 

 Protection 

Notes 
Movement Costs are dependent on the underlying 
terrain and are not affected by defensive structures, 
excepting movement between interconnected trench 
hexes. 
 

Improved 

 

8 

• 50% protection to vehicles from owning side. 
No protection to vehicles from the opposing 
side 

• 50% protection to infantry of opposing side 

Trench 

 

16 

• 50% protection to vehicles from owning side. 
No protection to vehicles from the opposing 
side 

• 50% protection to infantry of opposing side 

• movement between interconnected trench 
hexes has the same cost as clear terrain. 

 

Breastwork 

 

16 
Only provide protection to the unit occupying the 
associated hex 

Bunker 

 

32 No protection to vehicles 

Pillbox 

 

64 No protection to vehicles 

Cave 

 

64 

• If a cave has a facing, then units in the cave 
hex cannot fire at, or be fired upon by, units 
outside of the covered arc. 

• If an adjacent hex is higher than the cave, then 
the cave cannot be fire at or be fired upon by a 
unit occupying that hex. 

• No protection to vehicles 

• No protection to opponent units 

• No retreat if occupying unit loses assault. 

• Not affected by indirect fire 
 

Tunnel 

 

0 
The notation “NT” in the hex information box of a 
tunnel hex means no tunnel movement is allowed in 
that scenario (determined by PDT value) 

Sewer 

 

0  

 
 
  



 

Hex Side 
Features: 
Movement & 
Protection  

 Protection Movement Cost 

Infantry Wheeled Tracked 

Hedgerow* 
 

 

24 12 X 12 

Hedge 

 

0 8 12 8 

Tank Ditch 

 

0 12 X X 

Dune 

 

8 4 12 8 

Embankment** 

 

12 24 24 12 

Dike 

 

12 8 X X 

Escarpment** 

 

24 12 X X 

Wall 

 

16 4 24 12 

Reef 

 

0 X X X 

High Wall 

 

24 X X 6 

Cliff** 

 

24 X X X 

Fence 

 

0 24 X X 

*Vehicles crossing Hedgerows become vulnerable. Firepower against them is doubled and armour is halved. 
**Embankments, Escarpments and Cliffs only provide protection to the unit within the hex they are placed on the edge of. 
In each case illustrated above the protection is only afforded to the hex in the UPPER part of the image. 
  



 
 

Obstacles and Mines 
 

Wire 

 

• Infantry become pinned automatically. 

• Horses may not enter. 

• No effect on leaders or vehicles 

Barriers 

 

• Wheeled and tracked vehicles may not enter. 

• No effect on infantry or horses 

Booby Trap 

 

• If tripped always causes one casualty to infantry  

• Can be tripped by vehicles but will cause no damage 

Anti-
personnel 

mine 
 

• If tripped by Infantry entering hex in ground mode will always cause 1 
casualty 

• If tripped by infantry not in ground mode will cause between 1-5 
casualties 

• If tripped by soft vehicles will be immobilised no effect on hard 
vehicles 

Tank mine 

 

• No effect on infantry 

• Will destroy soft vehicle and unload any passengers. 

• Hard vehicles will be immobilised 

Teller Mine 

 

• Function as Tank mines when in water hexes, otherwise have no 
effect. Always visible 

Flame Mine 

 

• Combine the damage effects of both AP and Tank Mines 

 

 

Weapon Types 

 

 
 
Specialised weapon types are 
indicated by the symbol after the 
Fire Value.  
In the case above the * represents 
an indirect fire weapon 
 

- Single use. 

* Indirect fire. 

& Lethality doubled against vehicles, bunkers, and Pillboxes. 

^ Can only fire in the direction the vehicle is facing. 

! Anti-Air Only 

@ Guided Missile 

X Suicide weapon 

+ Sniper 

# Detection Device 

+++ Inspirational weapon (Displayed in place of a fire value) 

 



  

Unit Status 

 

Effects of Unit Status 
 

Disrupted 
 

 
 

• Movement costs are doubled. 

• Attack at 1/2 Strength in assaults. 

• Defend at 1/2 Strength if assaulted. 

• Fire value is at 50% 

• Cannot operate remote controls. 

• Sniper weapons lose their advantages and are treated as normal weapons. 

Pinned 
 

 
 

• Movement costs are doubled. 

• Unable to attack in assaults. 

• Defend at 1/4 Strength if assaulted. 

• Fire Value is at 50% 

• Must remain in “ground“ mode. 

• Cannot move closer to an enemy unit. 

• Will become demoralised if moves. 

• Cannot operate remote controls. 

• Sniper weapons lose their advantages and are treated as normal weapons. 
 

Demoralised 
 

 
 

• Movement costs are normal. 

• Cannot move closer to an enemy unit. 

• Unable to attack in assaults. 

• Defend at 1/8 Strength if assaulted. 

• Fire Value is at 25% 

• Cannot operate remote controls. 

• Sniper weapons lose their advantages and are treated as normal weapons. 
 



 

Toolbar Icons and Hotkeys 

Hot Key Icon Function Group 

Ctrl key 
 

Move/fire mode  

N 
 

Select Next stack  

P 
 

Select Previous stack  

Ctrl – Space 
 

Roaming mode  

J 
 

Open Jump map dialog  

Alt – ; 
 

Activate AI  

Ctrl – Shift – S 
 

Save battle  

F5 
 

Slow the speed of the A/I processing within the current phase  

F6 
 

Return A/I processing to normal speed within the current phase  

F7 
 

Increase the speed of the A/I processing within the current phase  

F8 
 

Put the A/I in the highest possible processing mode within the current 
phase  

Alt – Space 
 

Pause Replay or A/I turn (toggle)  

Ctrl – N 
 

Next turn  

Ctrl – D 
 

Unload/Drop units  

Ctrl – P 
 

Load/Pick Up units  

Ctrl – G 
 

Toggle on Ground mode  

Ctrl – L 
 

Turn Left  

Ctrl – R 
 

Turn Right  

Ctrl – X 
 

Remove From Map (eXit)  

Ctrl – W 
 

Select Weapon load  

Ctrl – F 
 

Toggle hold Fire  

Ctrl – S 
 

Toggle making Smoke  

Ctrl – M 
 

Toggle gas Masks  

Ctrl – T 
 

Toggle weapon timer  

Ctrl – Y 
 

RallY Units  

Ctrl – B 
 

Artillery/air support dialog (Bombard)  

Ctrl – C 
 

Attempt human wave Charge  

Alt – N 
 

Open arrived dialog (New units)  

Alt – G 
 

Open strength dialog  

Alt – Y 
 

Open victorY Dialog  

Alt – K 
 

Open last command dialog  



 

Toolbar Icons and Hotkeys 

Hot Key Icon Function Group 

Alt – O 
 

Open objectives dialog  

Mouse wheel 
Up  

Zoom-in  

Mouse wheel 
Down  

Zoom-out  

Keyboard \ 
 

Full Screen Map (toggle)  

Keyboard ` 
 

Show Location Labels (toggle)  

Keyboard – 
 

Show Objectives (toggle)  

Keyboard ] 
 

Show Map Slopes (toggle)  

Keyboard [ 
 

Show Map Contours (toggle)  

Keyboard ‘ 
 

Show Special Markers on Top (toggle)  

Alt – \ 
 

Open find unit dialog  

Y 
 

Show Company Markings (identifY) (toggle)  

Z 
 

Turn Units Off (Zero) (toggle)  

W 
 

Turn Weapons Off (toggle)  

V 
 

Shade Visible Hexes (toggle)  

H 
 

Shade Reachable Hexes (toggle)  

C 
 

Shade Command Range (toggle)  

X 
 

Shade maximum Range (toggle)  

I 
 

Shade Illuminated Hexes (toggle)  

F 
 

Highlight Fixed Units (toggle)  

M 
 

Highlight Units using Movement Points (toggle)  

S 
 

Highlight Spotted Units (toggle)  

T 
 

Highlight Target Units (toggle)  

B 
 

Highlight Human Wave Units (Berserk) (toggle)  

Q 
 

Highlight Organization (headQuarters) (toggle)  



 

Hotkeys Not Accessible From the Toolbar 

 
Hotkey Function 

Alt – A Open A/i menu 

Alt – C Open Command menu 

Alt – F Open File menu 

Alt – F5 Slow the speed of the a/i processing for the a/i turn 

Alt – F6 Return a/i processing to normal speed for the a/i turn 

Alt – F7 Increase the speed of the a/i processing for the a/i turn 

Alt – F8 Put the a/i in the highest possible processing mode for the a/i turn 

Alt – H Open Help menu 

Alt – I Open info menu 

Alt – J Open releases dialog (Join) 

Alt – L Open Location dialog 

Alt – M Open Mode menu 

Alt – Q Open organization dialog (headQuarters) 

Alt – S 
 

Open Settings menu 

Alt – T Open Turn menu 

Alt – U Open Units menu 

Alt – V Open View menu 

Alt – X Open withdrawals dialog (eXit) 

Alt – Z Open scheduled dialog 

Ctrl – Alt – F6 Return a/i processing to normal speed for all turn modes 

Ctrl – F5 Slow the speed of the a/i processing for the replay 

Ctrl – F6 Return a/i processing to normal speed for the replay 

Ctrl – F7 Increase the speed of the a/i processing for the replay 

Ctrl – F8 Put the a/i in the highest possible processing mode for the replay 

Ctrl – U Undo last movement 

Esc key Halts a/i processing during a/i turns and replays 

F1 Display main program help file 

F10 Display getting started file 

F2 Display user manual 

F3 Display parameter data 



 

 

Hotkeys Not Accessible From the Toolbar 

 
Hotkey Function 

F4 Display weapon data 

F9 Display campaign notes 

K Highlight commanded units (network play only) (toggle) 

Keyboard 1 Display the map in 2d zoom-out view 

Keyboard 2 Display the map in 2d normal view 

Keyboard 3 Display the map in 2d zoom-in view 

Keyboard 4 Display the map in 3d zoom-out view 

Keyboard 5 Display the map in 3d normal view 

Number Pad 0 Toggle on ground mode for the selected units 

Number Pad 1 Move the selected units down and to the left one hex 

Number Pad 2 Move the selected units down one hex 

Number Pad 3 Move the selected units down and to the right one hex 

Number Pad 4 Turn the selected units counterclockwise 

Number Pad 6 Turn the selected units clockwise 

Number Pad 7 Move the selected units up and to the left one hex 

Number Pad 8 Move the selected units up one hex 

Number Pad 9 Move the selected units up and to the right one hex 


